Chronolog 2.0: User Manual
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Chronological Toolkit

Chronolog is a software tool for computer-assisted chronological research in archaeology, available at
no cost at chrono.ulb.be. Running ChronoLog requires a working Java installation
(https://www.java.com/ES/download/).

This user manual succinctly presents the usage of ChronolLog from a practical perspective. For a more
detailed presentation of the ChronolLog principles, concepts, and data model, see:

Levy, E. and Geeraerts, G., Pluquet, F., Piasetzky, E. and Fantalkin, A.,
Chronological Networks in Archaeology: a Formalised Scheme. Journal of
Archaeological Science 127, 2021.

Part I: The ChronolLog data model

1. Chronological networks

ChronolLog enables users to model chronological data in the shape of a network. We define a
chronological network as an object consisting of three types of data: periods, sequences and
synchronisms, which are described below.

1.1. Periods

A period is defined as continuous interval of time, without gaps. It is characterized by a start date, an
end date, and a duration. While these three quantities are clearly correlated (since the duration is the
difference between the start date and the end date), each of them can be set independently in
Chronolog, as complete knowledge on all three parameters is not always available.

Bounds

Chronolog allows to encode lower bounds (i.e., minimal values) and upper bounds (i.e., maximal
values) on the start date, the end date and the duration of a period. None of these bounds are
mandatory. Hence the duration, start date and end date can either be unknown (no bound at all), lower
bounded (e.g., “at least 10 years”, or “after 1200 CE”), upper bounded (e.g., “at most 20 years”, or
“before 1300 CE”), in a range (e.g., “between 10 and 20 years”, or “between 1200 and 1300 CE”), or

known (e.g., “15 years”, or “1250 CE”).

Since version 2.0, Chronolog has two possible views on these data: the “full view” and the “concise

view”:


http://chrono.ulb.be/
https://www.java.com/ES/download/
https://doi.org/10.1016/j.jas.2020.105225

Full view. The full view (Figure 1) was the standard view used in ChronolLog up until version 1.2, and is
now deprecated. It shows all the lower and upper bounds for the duration, start date and end date of
each period, even unknown bounds (represented by a question mark). In this view a known date or
duration is represented by setting an equal value for the lower and the upper bound. Figure 1a gives
an example of a period in full view, with a start date after (or equal to) 1200 CE, an end date before
(or equal to) 1300 CE, and a duration of 50 years. The values located on the right side of the arrows
are the bounds computed by the software and will be explained below (Section 2a). Encoding or
modifying a bound is done by clicking directly on the bound, which displays an input dialog (Figure 1b).

Concise view. The new default view (since Chronolog 2.0), called the “concise view” (Figure 2),
represents these bounds in concise form. Instead of displaying all the 6 bounds (earliest start, latest
start, earliest end, latest end, minimum duration, maximum duration) explicitly, a summarized version
of the information is given, hiding unknown bounds, and showing exact values only once (rather than
with 2 bounds). The concise view shows the input bounds in straight fonts and the computed bounds
in italics.

Moving between the full view and the concise view is done via the “View” menu. This menu also allows
to show the inputs only, in concise view.

Period A =

Start: [ 1200 . ? ] - [ 1200 . 1250 ]
End: [ 7 . 1300 ] = [ 1250 . 1300 ]
Duration: [ 50 |, 30 ] —=1[ 350 ., 350 |]

(a) Full view: input bounds on the left, results on the right.

Start Date Bound *

@ Earliest start

2 Unknown
® Custom: 1200

OK Cancel

(b) The bounds input dialog.

Figure 1. (a) A ChronolLog period with a start date not earlier than 1200, an end date not later than 1300
and a duration of 50 years (full view). (b) The input dialog displayed when clicking on a bound. Note that the
bounds located on the left side of the arrows represent the encoded data, those on the right side of the data are
computed by the software.



Period A
(30y.)
[1200, 12500 - [1250,1300]

(a) Concise view (inputs [straight] and results [italics]). The duration is shown in the center,
the start date at the left, the end date at the right.

Period A
(50y.)
[after 1200] - [before 1300]

(b) Concise view (inputs only)

Inputs for Period & X

@ [“Start | End | Duration |
2 Unknown

2 Known:

® After: 1200

) Before:

) Range: from | | to |

| OK || Cancel ‘

(c) Editing a period in concise view.

Figure 2. (a) A ChronolLog period with a start date not earlier than 1200, an end date not later than 1300
and a duration of 50 years (concise view). (b) The concise view, showing inputs only. (c) The input dialog.

1.2. Sequences

A sequence is defined as a set of periods that are contiguous in time. The end date of a given period is
identical to the start date of the next period in the sequence. Every period belongs to exactly one
sequence. Figure 3 provides an example of a sequence in ChronolLog. The sequence contains two
periods, one of known duration (50 years), the other with bounded duration (between 20 and 40

years). The sequence is further known to have started after 1200 CE, and to have ended before 1300
CE.



Sequence S =
Period A =

) . 1250 ]

Start: [ 1200 ? |1~ [ 1200

End: [ 2?2 . ? ]—[ 1230 , 1280 ]

Duration: [ 30 |, 30 ] —=[ 30 ., 30 ]
Period B =

Start: [ ? s ? 1—[ 1230 |, 1280 |]
End: [ ? . 1300 |] — [ 1250 |, 1300 |]
Duration: [ 20 |, 50 ] —=[ 20 ., 50 ]

Figure 3. A sequence comprising two periods (in full view). The first period starts not earlier than 1200 CE and lasts
30 years. The second period ends not later than 1300 and lasts between 20 and 50 years.

1.3.  Synchronisms

We define a synchronism as any chronological relation involving two different periods. The simplest
type of synchronism is the contemporaneity synchronism, defined as two periods A and B having at
least one unit of time in common. In more formal terms, this synchronism is defined as period A not
ending before the start of period B, and period B not ending before the start of period A. ChronolLog
allows users to encode a wide set of possible types of synchronisms between periods. The window for
choosing a synchronism is shown in Figure 4. Clicking on a specific type of synchronism displays its
definition on the right side of the window.



“* Choosea synchronism X

[»
| ¥

Description

n®=

Choose a synchronism:

® A contemporaneous with B

=2 el nn

© A includes B

2 A starts during B “ ﬂ
© A includes start of B

© A ends during B ‘ Non-empty intersection ‘
= A includes end of B

Semantics

' A overlaps with succeeding B
end(A) == start(B) AND end(B) == start(A)

' A overlaps with preceding B
2 A & B start simultaneously
© Simultaneous start & B ends first

© Simultaneous start & A ends first
2 A & B end simultaneously

© Simultaneous end & A starts first
© Simultaneous end & B starts first

2 A & B start and end simultaneously
© A starts before the start of B

© A starts before the end of B

' A starts after the start of B

© A starts after the end of B

' A ends before the start of B

' A ends before the end of B

©' A ends after the start of B -
©' A ends after the end of B

2 A precedes immediately B
[ 1 [

-

[4]

| OK H Cn.ncel‘

Figure 4. The ChronoLog synchronism chooser dialog, showing all types of synchronisms supported by the software.

2. Operations on chronological networks

2.1. Consistency check

Given a chronological network comprising a set of sequences, periods and bounds, ChronolLog checks
automatically whether the encoded data are consistent with each other. For example, a period taking
place before 1200 CE cannot be contemporaneous with a period taking place after 1300 CE. The
consistency check is automatically launched every time a change is made to the network, i.e. every



time one adds, modifies or deletes a period, a sequence or a synchronism. In case the model is found
to be inconsistent, a pop-up dialog informs the user that the model is inconsistent, and proposes an
explanation as to why it is inconsistent (see Figure 5).

Period A Contermparaneous Sequence T 1
[7] - [before 1200] [after 1300] — [7]
Trace .

=)

The constraints are inconsistent.

OK Why?

Figure 5. An example of a non-consistent model (showing inputs only): period A ends not later than 1200, period B
starts not earlier than 1300, and both periods are linked by a contemporaneity synchronism.

2.2. Tightening

The tightening operation consists in using the encoded bounds and synchronisms in order to compute
the tightest possible ranges on each start date, end date and duration. These new bounds will be called
posterior (or computed) bounds. ChronolLog guarantees these bounds to optimal in the following
sense: no further tightening of the posterior ranges can be obtained using the encoded prior datal. In
other words, any more precision on the dates and durations can only be obtained by adding more data
into the system. The computed bounds are shown inside each period, after the arrows. Figure 6
provides an example of tightening.

Period A Contemporaneous Period B
(min 20 v.) (max 80%.)
[after 1200] — [before 1300] [after 1230] — [before 1350]

(a) Inputs only

1 For a mathematical justification of this statement, see: Gilles Geeraerts, Eythan Levy, and Frédéric Pluquet.
Models and Algorithms for Chronology, in: Proceedings of The 24th International Symposium on Temporal

Representation and Reasoning (TIME), 2017. Leibniz International Proceedings in Informatics, Vol. 13, p. 13:1-
13:18.



https://drops.dagstuhl.de/opus/volltexte/2017/7929/

Period A Contemporanenus Period B
(120, 100]y.) (max 80.)
[1200, 1280] - [1250,1300] [1250, 1300] — [1250, 1350]

(b) Result of the tightening procedure

Figure 6. Example of tightening. The values located on the right side of the arrows depict the posterior bounds. All
of the start date, end date and duration assumptions have been improved, except the duration of Period B.

Part II: User manual

3. File operations

3.1. Creating a new model

A new model is created using File 2New or by clicking the icon.

3.2. Opening and closing a model

A previously saved model file can be opened using File 2Open or by clocking the icon. A model
can be closed using File 2Close.

3.3.  Saving a model

B

A model can be saved into a file (with “.clog” extension) by using File=>Save or by clicking the
icon. Alternatively, one can use the “Save as” feature, available through File ?Save as.

3.4. Importing and exporting to CSV
In order to export to a CSV file the computed results (computed ranges) for each date and duration of
a model, use File 2Export results to CSV.

Exporting the input data of a model (sequences and synchronisms) is done in two steps: one needs to
export separately the sequences and the synchronisms. Two CSV files are thus created. To export the
sequences of a model to a CSV file, use File 2Export sequences to CSV. To export the synchronisms of
a model to a CSV file, use File 2Export synchronisms to CSV.

Once exported, the user can edit these files with any CSV editor if he wishes. To reimport them into
Chronolog, use File 2Import sequences to CSV (for sequences) and File 2Import synchronisms to CSV
(for synchronisms). The sequences file must be imported before the synchronisms file.

For all CSV import and export options, the separator is the semi-colon.



3.5. Resetting a model
The current model can be reset to a blank one using File DReset.

3.6. Exporting the model as an image
The current model can be exported as an image (png, jpg, gif or bmp) using File 2Export as image.

3.7. Exporting the model to OxCal
The current model can be exported as an OxCal (see https://c14.arch.ox.ac.uk/oxcal.html) Bayesian

radiocarbon model using File 2Export to OxCal or using the

R

icon. Chronolog then launches the

“OxCal export” dialog (Figure 7) into which users can encode their radiocarbon determinations for each
Chronolog period. In addition, the dialog allows the user to choose whether to use the input bounds
or the ChronoLog computed bounds in the OxCal script. ChronolLog then creates a script in the OxCal
language with Bayesian priors equivalent to the ChronolLog sequences, bounds and synchronisms.
Every Chronolog period is translated to a ChronoLog phase into which the radiocarbon determinations
are inserted. Alternatively, one can also export one sequence to OxCal, instead of the whole, model,

by clicking on the “Menu” button of the sequence toolbar, then choosing “Export sequence
to OxCal”. For full details on the conversion rules from Chronolog to OxCal, see:

Levy, E., Piasetzky, E., Fantalkin, A. and Finkelstein, I. 2022: From Chronological
Networks to Bayesian Models: ChronolLog as a Front-end to OxCal. Radiocarbon

64:101-134.
Export to OxCal: options X
@ [ ChronolLog options | [ C14 DATES (OPTIONAL) |
Which bounds would you like to use?
Phase/boundary: |Megiddo K8 |V|
® Input bounds
© Computed bounds [Name] : 14C Date : Uncertainty :

Settings

R_Date{2920,40);
R_Date{2945,40);

R_Date(2980,40); DELETE
R_Date(2990,55);

R_COMBINE

["] Resolution=1 [] Qutlier analysis {(general model)

["] Run OxCal immediately

Open in OxCal ‘ ‘ Save to file ‘ | Cancel

Figure 7. The “OxCal export” dialog.


https://c14.arch.ox.ac.uk/oxcal.html
https://doi.org/10.1017/RDC.2021.114
https://doi.org/10.1017/RDC.2021.114

4. Inserting sequences into a model

4.1. Creating a new sequence

A new sequence can be created using Insert 2New sequence or by clicking the button. This will
launch a dialog asking for the name of the sequence. The new sequence will contain only one period.
For adding new periods to the sequence, see below.

4.2. Inserting a component from the Chronolog library
A component can be added to the current model using Insert 2Insert from library or by clicking the

button. The component can consist of a single sequence, or a group of sequences, with possible
synchronisms between them. The component is added to the current model, without erasing its
current contents.

4.3. Inserting a component from a Chronolog file (c/log format)
A component can be added to the current model using a previously saved “.clog” file (see above for

instructions on file saving). This can be done using Insert 2Insert from file or by clicking the ﬁ'
button. The component contained in the file is added to the current model, without erasing the
model’s current contents.

4.4. Inserting a component from a CVS file

CVS files for sequences and synchronisms exported through File 2Export sequences to CSV (for
sequences) and File DExport synchronisms to CSV (see above) can be inserted in an existing model
using Insert 2Insert sequences from CSV (for sequences) and Insert 2Insert synchronisms from CSV.
The difference between these operations and the former operations File 2Import sequences from CSV
and File 2Import synchronisms from CSV is that the latter create a new model while the insertion
operations add data to the current model.

5. Editing sequences

5.1. Deleting a sequence

A sequence can be removed from the model by clicking the button located near the sequence
name, then clicking on “Delete sequence” (see Figure 8).




Period 1
(?)
71 - M

+ Add a period

B4 Rename sequence
@ Show/hide

# Tags

¥+ Reload

Z Set durations

A save sequence

% Export sequence to OxCal

X Delete sequence

Figure 8. Deleting a sequence

5.2.  Adding a period to a sequence

A period can be added at the end of a sequence by clicking the

sequence name, then clicking on “Add a period” (see Figure 9).

Period 1
(")
71 - [

button located near the

+ Add a period
B4 Rename sequence

@& Show/hide

# Tags

¥# Reload

Z Set durations

A save sequence

# Export sequence to OxCal
X Delete sequence

Figure 9. Adding a period to a sequence

5.3.  Renaming a sequence

A sequence can be renamed by clicking the
clicking on “Rename sequence”.

5.4. Hiding a sequence

A sequence can be hidden by clicking the

clicking on “Show/hide”. A hidden sequence appears as shaded and has no effect anymore on the
model. Neither its periods nor its synchronism are taken into consideration when checking the model’s
consistency and when computing the tightened ranges of dates and durations. Unhiding a sequence is

done by clicking on the same button.

button located near the sequence name, then

button located near the sequence name, then



5.5.  Saving a sequence to a file
A sequence can be saved to a “.clog” file in order to be inserted into future models. This is done by

clicking on the button located near the sequence name, then choosing “Save sequence”. A
saved sequence is saved “as is”, without other sequences and synchronisms.

5.6. Changing all period durations
The durations of all periods of a sequence can be changed at once. This is done by clicking on the

button located near the sequence name, then choosing “Set durations”.

5.7. Reloading a sequence
The default values of a sequence can be reloaded after they have been changed. This is done by clicking

on the button located near the sequence name, then choosing “Reload”. This only affects the
bounds of the dates and durations of the sequence’s periods. It has no effect on synchronisms. The
default values are defined as “unknown” for newly-created sequences, and as the initially loaded ones
if the sequences was loaded from a library or from a file.

5.8. Tagging a sequence

Each sequence can be assigned a series of tags. In order to add or remove tags from a sequence, click

on the “Menu” button of the sequence toolbar, then choose “Tags” (see Figure 10).

ChronolLand strata
+ Add a period

Stratum 2 B Rename sequence
(Em]ﬂ _3“[{-]} @ Show/hide
#' Tags
Stratum 1 43 Reload
(Eﬂ'fﬂf;']} Z Set durations

A Save sequence
%8 Export sequence to OxCal
X Delete sequence

Sequence Tags X

ChronoLand
Stratigraphy

ERE

Figure 10. Pop-up dialog showing the two tags (namely “ChronoLand” and “Stratigraphy”) of the sequence
“Chronoland strata”.

5.9. Hiding/showing sequences according to tags
The bottom part of the ChronoLog window contains the tags panel. This panel allows the user to
check/uncheck the desired tags. After clicking on “Select”, all tags that are unchecked are hidden from



the model, using the same sequence hiding mechanism as described above. The effect of this
procedure is that each sequence which has at least one unchecked tag becomes hidden (even if it does
have another that which is not hidden). Figure 11 provides an example of hiding a specific tag.

£ new model - Chronclog - U x

File Imsert View Window Help

DEB " 0B R £

IC

ChronoLand strata = ChronoLand kings
Starts during Albert
d (max. 10y.)
[1200, 1265] — [1200, 1265]
Ends during Baldwin
’ ([35. 1001 y.)
[1200. 1265] — [1235,1300]

[4]

q] Il | [»]

Tags: [¥|ChronoLand [ | Stratigraphy | [Select I ] .

2 periods modified

Figure 11. Hiding the “Stratigraphy” tag. This has the effect of automatically hiding the “ChronoLand strata”
sequence, since this sequence has the “Stratigraphy” tag (in full view).

5.10. Moving a sequence
Sequences can be moved by drag and drop, by clicking on the sequence name.

6. Editing periods

6.1. Renaming a period
A period can be renamed by clicking on it, then choosing “Rename” in the context menu (see Figure
12). Note that two periods may not have the same name.



& Edit

Ei Rename

X Delete

T Insert above
1 Insert below

~ Show trace

Figure 12. Changing the name of a period.

6.2. Deleting a period

A period can be deleted by clicking on it, then clicking on “Delete” in the context menu. Deleting a
period removes it from its sequences, and removes all its synchronisms from the model. The sequence,
and all the other periods contained in it, are not removed however.

6.3. Inserting a new period above a given period
A new period can be inserted above a given period. The new period is thus earlier in time than the
given period. This is done by clicking on the period, then choosing “Insert above” in the context menu.

6.4. Inserting a new period below a given period
A new period can be inserted below a given period. The new period is thus later in time than the given
period. This is done by clicking on the period, then choosing “Insert below” in the context menu.

6.5. Editing a prior bound

A newly created period has unknown prior bounds for its start date, end date and duration. In order
to set such a prior bound, one clicks on a period, then on “Edit” in the context menu. This will launch
a window enabling the user to input an unknown value for the bound, a known value, a lower bound,
an upper bound, or a range. Figure 13 shows an example of setting an earliest start date for a period.
Setting other types of bounds (latest start date, earliest end date, latest end date, minimum duration
and maximum duration) is done in the same way. Dates BCE are set using a negation sign, as in -1234.
Editing a period immediately launches a consistency check of the model, and recomputes the tightened
(posterior) ranges.

Inputs for Period P X
Period P
. [ start | End | Duration |
) =
M- & Edit ) Unknown
ﬂﬁ ) Known:
@ Rename ® After: (1200
X Delete O Before: ||
t Insert above ) Range: from | | to |
+ Insert below
~ Show trace




Figure 13. Setting an earliest start date of 1200 CE for a period.

6.6. Consulting traces

In order to obtain a trace (i.e. a justification) for a computed bound, click on the period, then on “Show
trace” in the context menu. A popup menu then asks the user for which bound he wants a trace. This
trace is then displayed in a separate pop-up dialog (see Figure 14). Bounds and synchronisms
participating in the trace are highlighted in pink (except for duration traces).

|£) Trace for: C ends after 1200 — O X

[]

C ends after 1200

Source: beg(A) >= 1200

— — Full trace:
A Contemparaneous B Starts during C beg(A) >= 1200
(50y.) (?) (?) |
1200 - 1250 [before 1250] — [after 1206] [before 1250) — [after 1200]
| beg (&) <= beg(D) 1
Starts hipre start of Ends gring |
v
D = beg (D) >= 1200
D |
(7 | beg (D) <= end(D)
[after 1200] — [after 1200] I

v
end (D) >= 1200
|
| end (D) <= end(C)
| |

end(C) >= 1200

Figure 14. Example of a trace showing why period C ends after 1200. The trace is graphically displayed in red, and the
involved bounds are shown in bold. A popup window also displays a mathematical view of the trace.

7. Working with synchronisms

7.1. Adding a synchronism

A synchronism can be added by connecting two periods directly with the mouse, or by using the
synchronisms panel accessible through Window =2Synchronisms. In both cases, a dialog appears asking
the user to choose the desired type of synchronism. Each synchronism type is provided with a formal
definition and an explanatory figure (see Figure 15). Another way to connect two periods, especially
useful for periods that are far from each other, is to click on a period, drag a line and release it in an
empty spot. A dialog then appears asking the user to choose the destination period (see Figure 16).



SYNCHRONISMS

|Stratum 2 |'| | Choose a synchronism | |Baldw1'11 |'| ‘ Go ‘

1 |Stratum 2 starts during Albert | II|

|Stratum 1 ends during Baldwin | IIl

@ Choose a synchronism

\4

Choose a synchronism:
® A contemporaneous with B
© A is included in B

© A includes B

© A starts during B

' A includes start of B

' A ends during B

= A includes end of B

© A preceeds and intersects by B
' A succeeds and intersects B

= A & B start simultaneously

Description—————

= o=

‘ Non-empty intersection ‘

Semantics
end(A) == start(B) AND end(B) == start(A)

[»

!

1 [»]

[«]

Figure 15. The synchronisms creation dialog.
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Stratum 2 Starts during Albert
([20.80]y.) ’ (max 10y.)
[1200, 1260] — [1220, 1280] [1200, 1260] — [1200, 1265]
Stratum 1 Ends during Baldwin
(120, 80]y.) y (135, 100] y.)
[1220,1280] — [1240, 1300] [1200, 1265] — [1240,1300]

Create a synchronism X
E Choose destination period:
Sequence: Period:
|ChmnuLnnd Ki... |"| |A1hert “'|
OK Cancel -
]

1 | m I

Tags: [w] ChronoLand [v] Stratigraphy Select :Q:

4 periods modified

Figure 16. Creating a synchronism by releasing the mouse in empty space.

7.2.  Consulting a synchronism
Each synchronism appears both as an arrow connecting two periods. Clicking on a synchronisms arrow
displays a small pop-up dialog showing the full name of the synchronism, and allowing to hide it,

modify it or delete it (see Figure 17).



ChronoLand strata ChronoLand kings
Stratum 2 Starts during Albert
([20,80]y.) q (max. 10y.)
[1200, 1260] — [1220, 1280] [1200, 1260] — [1200, 1265]
Stratum 1 Endd during Baldwin
([20,80]y.) 4 (135, 100]y.)
[£220,1280] — [1240, 1300] [£200, 1265] — [1240,1300]
VvV
Synchronism x
G
Stratum 2 starts during Albert Modify
Hide
Delete
OK

Figure 17. Pop-up dialog obtained by clicking on a synchronism.

7.3. Deleting a synchronism
A synchronism can be deleted by clicking on the synchronism’s arrow, then clicking on the “Delete”
button of the ensuing pop-up dialog (see Figure 17). Alternatively, one can also delete the synchronism

x
by clicking on the button of the synchronisms panel.

7.4. Hiding a synchronism
A synchronism can be hidden by clicking on the synchronism’s arrow, then clicking on the “Hide”
button of the ensuing pop-up dialog (see Figure 17). Alternatively, one can also delete the synchronism

by clicking on the R button of the synchronisms panel. A hidden synchronism is no longer part
of the current model, and thus is not taken into account when checking the consistency of the model
nor in computing the tightened bounds. In order to unhide a synchronism, repeat the same operation.

7.5. Modifying a synchronism
The type of a synchronism can be modified by clicking on the synchronism’s arrow, then clicking on
the “Modify” button of the ensuing pop-up dialog (see Figure 17).

7.6.  Moving a synchronism
A synchronism’s arrow can be moved by clicking and dragging it with the mouse (see Figure 18).



Starts during

ChronoLand strata

ChronoLand kings

Stratum 2 / \ Albert
(120,501 y.) (max 10y.)
[1200, 1260] — [1220, 1280] [1200, 1260] — [1200, 1265]
Stratum 1 Ends during Baldwin
([20.80y.) ’ ([33. 1001 y.)
[1220,1280] — [1240, 1300] [1200, 1265] — [1240,1300]

Figure 18. Moving the synchronism between “Stratum 2” and “Albert”.

8. Visual tools

The model can be zoomed in through View 2Zoom in and View 22Zoom out, or through the sliding
bar located at the bottom right of the ChronoLog window.

Part lll: Example: the Kingdom of Chronoland

1. Introduction

This section presents an artificial example called “ChronolLand”, which represents a simple use case
with two kings and two archaeological strata, with two synchronisms between kings and strata. The
purpose of the example is to show that even in such a small data set, computing the optimal
chronological bounds (as well as performing other types of queries, see below) is not an easy task
without the aid of a computational tool such as Chronolog.

2. Data

In the Kingdom of Chronoland, Kings Albert and Baldwin reigned in succession. We do not know their
precise reign dates, but both reigns are known to have occurred between 1200 and 1300 CE. We also
know from ancient annals that Albert’s reign did not exceed 10 years, and we know from epigraphic
sources that Baldwin reigned at least 35 years. Recent excavations at ChronoCity, the capital city of
Chronoland, have unearthed two archaeological strata: Stratum 1 and Stratum 2. The earlier stratum,
Startum 1, was built on bedrock, and contained an in-situ stela of King Albert, claiming he built
ChronoCity. The latest stratum, Stratum 2, was destroyed by fire in a heavy conflagration. According
to ancient annals, the city was destroyed during the reign the reign of King Baldwin and was never
reoccupied. Finally, we assume that each of our strata has a duration of at least 20 years.

3. Modelling

In order to simplify things, we first show (Figure 19) the modelling of the ChronolLand example with
only its input data (recall that a view showing only inputs is available through View >View
mode 2>Concise view (inputs only)). Figure 20 then shows the complete ChronolLand model, with the
computed (optimal) bounds in italics. These bounds are the result of the tightening operations. Some
of them are straightforward: the 1265 upper bound on the start of Baldwin stems from the 1300 latest
end of Baldwin and the 35 years minimum duration of his reign. Others are more tricky, like the 1240
lower bound on the end of Baldwin’s reign. This bound stems from a longer chain of implications,
starting from the 1200 lower bound on the start of Albert, going through the 20 years minimum



duration of Stratum 2 (via the “starts during” synchronism), the 20 years minimum duration of Stratum
1, then looping back to Baldwin through the “ends during” synchronism

ChronoLand strata ChronoLand kings

Stratum 2 Starts during Albert
(max. 10v.)
[after 1200] — [7]

-

(min. 20 y.)

Stratum 1 Ends during Baldwin
(min 20y.) ’ (min. 35 y.)
[71 — [before 1300]

Figure 19. Modelling the ChronoLand data with ChronolLog (showing inputs only).

ChronoLand strata ChronoLand kings
Stratum 2 Starts during Albert
([20. 507 v.) » (max. 10y.)
[1200. 1260) - [1220. 1280] [1200, 1260) — [1200, 1265]
Stratum 1 Ends during Baldwin
(120,80].) > (133, 100].)
[1220, 1280) — [1240, 1300] [1200, 1265] — [1240, 1300]

Figure 20. Modelling the ChronolLand data with ChronolLog (showing all data)

ChronoLand strata ChronoLand kings

Stratum 2 E' Albert E

Sart [ ? . 2 []=[ 1200 _ 1260 ] Starts during | st 100 L 2 ][ 1200 [ 1260 ]
End:[| ? . ? |1-1[ 1220 . 1280 |] (" [ 2 . 2 |1-=1 1200, 1265 ]
Duration: [ 20 |, ? |1 —=[ 20 |. 80 |] Duration: [ 0 |, 10 |]—=[ o0 . 10 |]
Stratum 1 El Baldwin El

Start [ ? . 2 []—[ 1220 _ 1280 ] Ends during | osael o2 L2 1 1200 | 1265 ]
End:[| ? |. ? |1-1[ 1240 _ 1300 |] | End: [| ? |. 1300 ] —[ 1240 _ 1300 ]
Duration: [ 20 |.| 2 1= 20 . 80 |] Duration: [ 35 .| 2 |1—=1[ 35 . 100 |]

Figure 21. Modelling the ChronoLand data with ChronoLog (“Full view”)

The bounds located on the right side of the arrows are the result of the tightening operations. Some
of them are straightforward: the 1265 upper bound on the start of Baldwin stems from the 1300 latest
end of Baldwin and the 35 years minimum duration of his reign. Others are more tricky, like the 1240
lower bound on the end of Baldwin’s reign. This bound stems from a longer chain of implications,
starting from the 1200 lower bound on the start of Albert, going through the 20 years minimum



duration of Stratum 2 (via the “starts during” synchronism), the 20 years minimum duration of Stratum
1, then looping back to Baldwin through the “ends during” synchronism.

For the sake of completeness, we also provide the (now deprecated) “full view” (recall that the full
view was the standard view until Chronolog 1.2, and can still be accessed through View 2View
mode 2Full view) in Figure 21. In this view, the bounds located on the left side of the arrows are the
input bounds, and the bounds located on the right side of the arrows are the result of the tightening
operations.

Figure 22 presents the full trace for this computed bound, as obtained by clicking on the “1240” button
in Chronolog.



|%| Trace for: Baldwin ends after 1240 — O .

Baldwin ends after 1240 »

Source: beg(Albert) >= 1200

Full trace:

beg(Albert) >= 1200
I
| beg (Albert) <= beg(Stratum 2)
I

beg(Stratum 2) >= 1200

I
| duration(Stratum 2) >= 20

end (Stratum 2) >= 1220

I
| end (Stratum 2) = beg(Stratum 1)

beg(Stratum 1) >= 1220

I
| duration(Stratum 1) >= 20

end (Stratum 1) >= 1240

I
| end (Stratum 1) <= end(Baldwin)

v —=

end (Baldwin) >= 1240

[4]

OK

Figure 22. A justification of the computed 1240 lower bound for the end of Baldwin’s reign, as obtained by Chronolog (by
clicking on the “1240” button).



4. Querying the model

a. Detecting inconsistency in a model

One usage of Chronolog is to test the global impact of a local change to the chronological
network. For example, what if Baldwin reigned at most 25 years, instead of at least 35 years?
In this case, ChronoLog will report that the model is not consistent, as shown in Figure 23. Here
again, ChronolLog reports automatically the cause of the inconsistency, as shown in Figure 24.
Here, the cause stems from the fact that the new 25 years upper bound yields a 35 years
maximum duration for the whole dynasty, which is not enough to encompass the 40 years
minimum duration (20 + 20 years) of the two strata.

ChronoLand strata ChronoLand kings
Stratum 2 Starts during Albert
(?y.) v (?y.)
[before 7] — [before 7] [before 7] — [before 7]
Stratum 1 Ends during Baldwin
(?y.) v (?y.)
[before 7] — [before 7] [before 7] — [before 7]
Trace >
? The constraints are inconsistent.

OK || Why?

Figure 23. Changing the duration bounds of Baldwin to maximum 25 years yields an inconsistency result.



£ Inconsistency trace

£ -
'\D The prior constraint: duration(Stratum 2) >= 20
contradicts the computed constraint: duration(Stratum 2) <= 15

Trace for: duration(Stratum 2) <= 15

beg (Stratum 2)
|
| beg(Albert) <= beg(Stratum 2)
|
v
beg (Albert)
|
| duration (Albert) <= 10
|
v
end (Albert)
|
| beg(Baldwin) = end (Albert) L
|
v
beg (Baldwin)
|
| duration (Baldwin) <= 25
|

v
end (Baldwin)
|

1 Aror +. 11 AIDT AraiaN

Figure 24. Chronolog trace for the inconsistency result when limiting Baldwin’s duration to 25 years (partial view).

b. Checking the global impact of local changes to the network

What if we wish to set a realistic upper bound on the reign length of Baldwin. We know he
reigned at least 35 years, but clearly no king can reign forever. How would a bound of, say, 70
years on his reign affect the overall chronology? Such questions are not easy to answer without
a computational tool. Chronolog’s answer to this question is shown in FIGFGG: the two strata
get an upper bound of 60 years instead of 80 years. This stems from the fact that the maximum
duration of the dynasty is now 80 years and that each stratum lasts at least 20 years. Hence
the other stratum can last at most 80-20 years.

ChronoLand strata ChronoLand kings
Stratum 2 Starts during Albert
([20.60]v.) ’ (max. 10v.)
[1200, 1260] - [1220. 1280] [1200, 1260] — [1200, 1265]
Stratum 1 Ends during Baldwin
( [20, 607 y.) > ([33.70]¥.)
[1220, 1280] — [1240. 1300] [1200, 1265] — [1240, 1300]

Figure 25. Result of setting an additional 70 years upper bound on Baldwin’s reign.



c. Testing hypotheses

Chronolog also allows to test hypotheses. We know for example that stratum 2 was built by
Albert. But who built stratum 1? The computed date ranges do not provide an answer, since
stratum 1 starts in the range [1220-1280], which could a priori correspond both to Albert’s
reign (located within the range [1200-1265]) and Baldwin’s reign (located within the range
[1200-1300]). Let us therefore test whether it is possible that Albert built stratum 1. We
therefore add the synchronism “Stratum 1 starts during Albert” to the model. This new
synchronism yields an inconsistency, detected by ChronolLog: stratum 1 cannot have been built
by Albert, because this would require the whole of stratum 2 to be included within Albert’s
reign, which is too short (at most 10 years) to encompass the whole of stratum 2’s duration (at
least 20 years). We can thus conclude that stratum 1 was built during Baldwin’s reign. This is
illustrated in Figure 26.

ChronoLand strata ChronoLand kings

Stratum 2 Starts during Albert

(7y-) (7y)
[before 7] — [before 7] [before 7] — [before 7]

Starts d

Stratum 1 Ends during Baldwin
(7y) y (7y.)
[bgfore 71 — [before 7] [before 7] — [bgfore 7]

Trace ot

"

The constraints are inconsistent.

OK Why?

Figure 26. Result of adding the synchronism “Stratum 1 starts during Albert” to the model. ChronolLog detects an
inconsistency, implying that stratum 1 was built during Baldwin’s reign.
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